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1. FORWARD 

 
The module D11 is assigned content wise to Industrial field bus systems. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Learning goal: 
 
In this module, the reader should learn how a FDL connection to a PROFIBUS DP with two SIMATIC 
S7-300 with the communication processor CP 342-5DP as a master is taken into operation.  The 
module shows the principle procedure by means of a short example. 
 
  
 
Requirements: 
 
For the successful use of this module, the following knowledge is assumed: 
 
• Knowledge in the use of Windows 95/98/2000/ME/NT4.0 
• Basics of PLC- Programming with STEP 7 (e.g. Module A3 - ‘Startup’  
 PLC programming with STEP 7) 
• Basics of the PROFIBUS DP (e.g. Appendix IV – Basics of  

field bus systems with SIMATIC S7-300) 

Basics of 
STEP 7- Programming 
2 - 3 days     A modules 

Industrial field bus 
systems 

2- 3 days D modules 

Additional functions of 
STEP 7- Programming 
2- 3 days    B modules 

Process 
visualization 

2- 3 days F modules 

Sequencer 
Programming 

2- 3 days C modules 

IT- Communication 
with SIMATIC S7 

1- 2 days E modules 
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Required hardware and software  
 
1 PC, Operating system Windows 95/98/2000/ME/NT4.0 with 

- Minimal: 133MHz and 64MB RAM, approx. 65 MB free hard disk space 
- Optimal: 500MHz and 128MB RAM, approx. 65 MB free hard disk space 

2 Software STEP 7 V 5.x with option NCM S7 PROFIBUS 
3 MPI- Interface for the PC (e.g. PC- Adapter) 
4     PLC SIMATIC S7-300 with the CP 342-5DP  
 Example configuration: 

- Power supply: PS 307 2A 
- CPU: CPU 314IFM 
- PROFIBUS- Communication processor: CP 342-5DP 

5     PLC SIMATIC S7-300 with the CP 342-5DP  
 Example configuration: 

- Network: PS 307 2A 
- CPU: CPU 314IFM 
- PROFIBUS- Communication processor: CP 342-5DP 

6 PROFIBUS cable with 2 PROFIBUS slots  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
1 PC 

 
2 STEP 7 

3 PC Adapter 

 
4 SIMATIC S7-300 with  

CP 342-5DP 

 
5 SIMATIC S7-300 with  

CP 342-5DP 
6 PROFIBUS cable 
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2. NOTES FOR THE OPERATION OF THE CP 342-5DP 

 
The PROFIBUS communication processor CP 342-5DP makes it possible to attach to itself the 
SIMATIC S7-300 by the PROFIBUS with the protocol profile distributed I/O (DP). 
 

The parameterizing of the PROFIBUS parameters for the PLC, such as the configuration of the 

PROFIBUS network, takes place with the software STEP 7. The requirement is the CP342-5DP and 

additionally the software “NCM S7 PROFIBUS “ (Contained already in STEP 7 V5.x!), so that the user 

has a uniform configuration tool for centralized and distributed configuration.  

 
For the SIMATIC S7-300 with the CP342-5 as a Combimaster, the following protocol profiles are at your 
disposal: 
• DP- Interface as master or slave according to EN 50170. PROFIBUS-DP (Distributed I/O) is the 
 protocol profile for the connection of the distributed I/O/field equipment with a quick reaction 
 time. 
• SEND/RECEIVE- Interface (AG/AG) according to the SDA-Service (Layer 2 of the  
 PROFIBUS). SEND/RECEIVE (FDL- Interface) offers functions with which the  
 communication between SIMATIC S5 and S7 are under one another and they can simply and 
 quickly be realized to the PC. 
• S7-Functions. These offer optimal communication in the SIMATIC S7/M7/PC-connection. 
 
On the part of the user program, the transmission of the data range for the DP and FDL communication 
is activated through programmed FC-Block calls and monitoring of effective execution monitored. 
The block calls for the important communication FC blocks are found in the library  
“SIMATIC_NET_CP“. In order to use these functions, the function must be copied into the project. 
 
Note:  Here 2 SIMATIC S7-300 with the CP 342-5DP are appointed to a PROFIBUS.  
  Both should be masters on the network and should communicate with each other over a  
 FDL connection. 
  It would also be possible to assign each master a pair of slaves at the same time. 
 
The FDL connection enables a program controlled communication between 2 stations by the 

PROFIBUS with the following properties:  

• The data transfer is bi-directional, e.g. it can send and received on the AG/AG connection 

 simultaneously. 

• Both stations are asynchronous, e.g. each station can activate a send and receive operation 

 which is result dependent. 

• The CP342-5 can operation a maximum of 16 connections. It can send and receive 240 bytes 

 pro job. 
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3. COMMISSIONING THE PROFIBUS ( MASTER CP 342-5DP / MASTER CP 342-5DP) 

In the following example, the commissioning of a multi master system with two SIMATIC S7-300 with 

CP 342-5DP as a master is described. 

For the testing of the configuration, a program will be written in which an input (SET) can be preset in 

each PLC. This byte is transferred over the PROFIBUS to the other PLC and can then be displayed 

over a display byte (DISPLAY). 

 

Assignment list Master- CPU1: 
IB 124 SET   Input byte 
IB 40 Comm_IB1  Input communication Byte1 
QB 124 DISPLAY  Display byte 
QB 40 Comm_QB1  Output communication Byte1 
 
Assignment list Master- CPU2: 
IB 124 SET   Input byte 
IB 40 Comm_IB1  Input communication Byte1 
QB 124 DISPLAY  Display byte 
QB 40 Comm_QB1  Output communication Byte1 
 
For the connection of the two CPU342-5DP, whereby one is set as a master and the other as a slave, 

the following steps must be followed. 

 

 

1.  The central tool in STEP 7 is the SIMATIC Manager, which is opened here with a double click       

( → SIMATIC Manager). 
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2.  STEP 7- Programs are administered in projects . Such a project will be created ( → File → New). 
 

  
 
 
3.  Give the Name CP342_FDL to the project ( → CP342_FDL → OK) 
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4. Highlight your project and insert a PROFIBUS Subnet (→ CP342_FDL → Insert → Subnet → 

PROFIBUS). 
 

 
 
5. Then insert a SIMATIC 300-Station (→ Insert → Station → SIMATIC 300-Station). 
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6.  Change the name of the station to Master1 (→ Master1). 
 

  
 
7.  Open the configuration tool for the Hardware  with a double click (→ Hardware). 
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8.  Open the hardware catalog with a click on the symbol   (→ ). 
There you will see the directories are divided into the following: 
- PROFIBUS-DP, SIMATIC 300, SIMATIC 400 and SIMATIC PC Based Control, 
all module racks, modules and interface modules for the configuration of your hardware configuration 
are made available.  
Insert a Rail with a double click( → SIMATIC 300 → RACK-300 → Rail). 

 

  
 

After the insert, a configurations table for the configuration of the Rack 0 appears automatically. 
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9.  Now all modules can be chosen out of the hardware catalog and inserted into the configuration 

table and are also inserted into your rack.  To insert, you must click on the name of the respective 
module, hold the mouse button and Drag & Drop the module into a line of the configurations table.  
We will begin with the power supply PS 307 2A (→ SIMATIC 300 →PS-300 → PS 307 2A). 

 

 
 
 
 
Note: If your hardware differs from what is shown above, then you must select the appropriate       
modules from the catalog and insert them into the rack.  The part numbers of the individual modules, 
which are found on the components, are indicated in the footer of the catalog.

 

 



         Automation– and Drive Technology- SCE 
   

 
T I A  Training document Page 13 of 37              Module D11 

Last revision: 02/2002                                                                                    PROFIBUS-DP with Master CP 342-5DP / Master CP 342-5DP 

Forward                                     Notes                                     Commission 

 
10. In the next step, we drop the CPU 314IFM into the second card location.  This allows for the part 

number and version of the CPU to be read off (→ SIMATIC 300 →  CPU-300 → CPU 314IFM → 
6ES7 314-5AE03-0AB0 → V1.1 ). 

 

  
 
 
Note:  The addresses of the integrated in-/outputs by the CPU314IFM can be read into the  
  hardware configuration.  However, they are directly on the CPU. 
  They are the digital inputs IB124 and IB125 such as I126.0-I126.3.  
  The digital outputs have the addresses QB124 and QB125. 
  The analog inputs are found on PIW128, PIW130, PIW132 and PIW134. 
  The analog output is found on PQW128. 
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11. Then we drag the communication processor for the PROFIBUS CP 342-5DP onto the fourth slot. 

Now the order number and version of the model can be read off the front (→ SIMATIC 300 →  CP-
300 → PROFIBUS →  CP 342-5DP → 6GK7 342-5DA01-0XE0 → Product Version 2). 

 
. 
 
 

 
 
 
 
Note: Slot number 3 is reserved for interface modules and remains empty. The order number of the 
module is displayed in the footer of the catalog.
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12. By the entering of the communication processor, the following window appears, in which you   

assign a PROFIBUS address to the CPU 342-5DP and must already choose the first PROFIBUS 
net. When you want to alter the parameter of the PROFIBUS net, you must highlight it and then 
click on Properties (→ 2 → PROFIBUS(1)). 

 

  
 
13. Now you can choose the Highest PROFIBUS Address (here → 126), the Transmission Rate 

(here → 1,5 Mbit/s) and the Profile (here → DP). (→ OK). 
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14.  Now the addresses of the communication processor in the I/O address space of the CPU  

        are noted (Here: PI 256...271 / PQ 256..271).  Choose the properties of the communication  
        process through a double click on the ‘CP 342-5DP’ ( → CP 342-5). 
 

  
 
15. Set the Operation Mode  to DP master and accept with OK ( → Operation Mode → DP master 

→ OK). 
 

  

 



         Automation– and Drive Technology- SCE 
   

 
T I A  Training document Page 17 of 37              Module D11 

Last revision: 02/2002                                                                                    PROFIBUS-DP with Master CP 342-5DP / Master CP 342-5DP 

Forward                                     Notes                                     Commission 

 

16. The configuration table is saved and compiled now with a click on . Then the hardware 

configuration is closed with a click on x   ( →  → x ).   
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17. Now in SIMATIC Manager enter an additional SIMATIC 300-Station (→  SIMATIC Manager → 

Insert → Station → SIMATIC 300-Station). 
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18.  Change the name of the station to Master2 (→ Master2). 
 

 
 
19.  Open the configuration tool for the Hardware  with a double click (→ Hardware). 
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20. Open the hardware catalog with a click on the symbol   (→ ). 
There you will see the directories are divided into the following: 
- PROFIBUS-DP, SIMATIC 300, SIMATIC 400 and SIMATIC PC Based Control, 
all module racks, modules and interface modules for the configuration of your hardware                           
configuration are made available. 

      Insert a Rail with a double click( → SIMATIC 300 → RACK-300 → Rail). 
 

 

  
 

After the insert, a configurations table for the configuration of the Rack 0 appears automatically. 
 

 



         Automation– and Drive Technology- SCE 
   

 
T I A  Training document Page 21 of 37              Module D11 

Last revision: 02/2002                                                                                    PROFIBUS-DP with Master CP 342-5DP / Master CP 342-5DP 

Forward                                     Notes                                     Commission 

 
21.  Now all modules can be chosen out of the hardware catalog and inserted into the configuration 

table and are also inserted into your rack.  To insert, you must click on the name of the respective 
module, hold the mouse button and Drag & Drop the module into a line of the configurations table.  
We will begin with the power supply PS 307 2A (→ SIMATIC 300 →PS-300 → PS 307 2A). 

 

  
 
 
 
Note: If your hardware differs from what is shown above, then you must select the appropriate       
modules from the catalog and insert them into the rack.  The part numbers of the individual modules, 
which are found on the components, are indicated in the footer of the catalog.
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22. In the next step, we drop the CPU 314IFM into the second slot.  This allows for the part number 

and version of the CPU to be read off the front (→ SIMATIC 300 →  CPU-300 → CPU 314IFM → 
6ES7 314-5AE03-0AB0 → V1.1 ). 

 

  
 
 
 
 Note:  The addresses of the integrated in-/outputs by the CPU314IFM can be read into the  
  hardware configuration.  However, they are directly on the CPU. 
  They are the digital inputs IB124 and IB125 such as I126.0-I126.3.  
  The digital outputs have the addresses QB124 and QB125. 
  The analog inputs are found on PIW128, PIW130, PIW132 and PIW134. 
  The analog output is found on PQW128. 
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23. Then we drag the communication processor for the PROFIBUS CP 342-5DP onto the fourth slot. 

Now the order number and version of the model can be read off the front (→ SIMATIC 300 →  CP-
300 → PROFIBUS →  CP 342-5DP → 6GK7 342-5DA01-0XE0 → Product Version 2).   
  
 

 
 
 
 
 

 
 
 
Note: Slot number 3 is reserved for interface modules and remains empty. The order number of the 
module is displayed in the footer of the catalog.
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24. By the entering of the communication processor, the following window appears, in which you   

assign a PROFIBUS address to the CPU 342-5DP and must already choose the first PROFIBUS 
net (→ 4 → PROFIBUS(1)). 
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25. Now the addresses of the communication processor in the I/O address space of the CPU are 

noted (Here: PI 256...271 / PQ 256..271).  Choose the properties of the communication process 
through a double click on the ‘CP 342-5DP’ ( → CP 342-5). 

 

  
 
26. Set the Operation Mode  to DP master and accept with OK ( → Operation Mode → DP master 

→ OK). 
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27. The configuration table is saved and compiled now with a click on . Then the hardware 

configuration is closed with a click on x   ( →  → x ). 
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28.  So that both CPUs can be exchanged over the PROFIBUS and the FDL connection data, one 

must first open the folder Connections in either of the stations (here Master1 ) with a double click 
in SIMATIC Manager ( → SIMATIC Manager →Connections). 

 

 
 
29.  Then the tool NetPro is opened. Here we have a good summary about the linking network of the 

available components from the MPI and PROFIBUS.  One of the CPUs is already chosen so now 
we must click on the menu command Insert New Connection ( → Insert → New Connection). 
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30.  The other station Master2 is chosen as a connection partner with the other inserted CPU 314IFM. 

The connection type is FDL connection ( → Master2 → CPU 314 IFM → FDL connection →OK) 
 

  
 
 
31.  Out of the connection table, the ID  of both connection partners is read off  (Here both are set to 

1). Now save and compile the connection table with a click on  ( →  ). 
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32.  Choose the compile option Compile and check everything ( → Compile and check everything 

→OK). 
 
 

 
 
 

33.  The following windows with the warning and error messages is closed with x  ( → x ). 
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34. From the SIMATIC Manager, open the block OB1 for the Master1 with a double click ( → OB1). 
 

  
 
 
35.  Optional:  Enter the properties of the OB1 for documentation and accept with OK ( →OK). 
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On part of the user program, the transmission of the data range for the FDL ommunication is activated 
through the programmed FC block call and the effective execution is monitored.   
The block calls for the important communication FC blocks are found in the library  
“SIMATIC_NET_CP“. In order to use these functions, the functions must be copied into the project. 
 
The FC block AG-SEND assigns data to the PROFIBUS-CP for the transmission over a configured FDL 
connection. 
The indicated data range can be an I/O range, a bit memory address area, or a data block area. 
The error free execution is signaled when the whole FDL data range is transferred over the PROFIBUS 
DP. 
For the calling of the FC block AG-SEND, the following parameters must be entered: 
 

Name Type Range of values Comment 

ACT BOOL 0, 1 By ACT=1, LEN bytes are sent out of the given FDL data 

range with the parameter SEND. 

By ACT=0, the status display updates DONE, ERROR 

and STATUS. 

ID INT 1, 2,...16 Connection number of the FDL connection 

LADDR WORD  Module start address (can be withdrawn from the 

configuration table in STEP 7). 

SEND ANY  Indication from the address and length of the FDL send 

range (The address can refer to PA ranges, bit memory 

address areas and data block areas). 

LEN INT 1, 2,...240 Display of the bytes, that should be sent with the job from 

the FDL data range. 

DONE BOOL 0: - 

1: New data 

State parameters displayed if the execution is handled 

error free. 

ERROR BOOL 0: - 

1: Error 

Error display 

STATUS WORD  Status display 
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The FC block AG-RECV accepts transferred data from the PROFIBUS-CP over a configured FDL 
connection. 
The indicated data range can be an I/O range, a bit memory address area or a data block area. 
The error free execution is signaled, when the whole FDL data range is transferred over the PROFIBUS 
DP. 
By the call of the FC block AG-RECV, the following parameters must be entered: 
 

Name Type Range of values Comment 

ID INT 1, 2,...16 Connection number of the FDL connection 

LADDR WORD  Module start address (Can be withdrawn from the 

configuration table in STEP 7). 

RECV ANY  Indication from the address and length of the FDL send 

range (The address can refer to PA ranges, bit memory 

address areas and data block areas). 

LEN INT 1, 2,...240 Display of the bytes that would be accepted from the 

PROFIBUS-CP in the FDL data range. 

NDR BOOL 0: - 

1: New data 

The mode parameter is displayed if new data is accepted. 

ERROR BOOL 0: - 

1: Error 

Error display 

STATUS WORD  Status display 

 

 

 



         Automation– and Drive Technology- SCE 
   

 
T I A  Training document Page 33 of 37              Module D11 

Last revision: 02/2002                                                                                    PROFIBUS-DP with Master CP 342-5DP / Master CP 342-5DP 

Forward                                     Notes                                     Commission 

 
36. With LAD, STL, FBD: Program blocks, you now have an editor which gives you the possibility to 

generate your STEP 7- Program.  Here the organization block OB1 was already opened with the 
first network.  In order to generate your first logical operation, you must highlight the first network.  
Now you can write your first STEP 7- Program.  Several programs can usually be divided into 

networks.  Open a new network by clicking on the network symbol  . 
 
Here the received data is read into network 1 as inputs from Master2 with the block AG_RECV. You 
can drop this block into your network from the Libraries of blocks in the catalog ( → Libraries → 
SIMATIC_NET_CP → CP 300 → FC6 AG_RECV) 
 
In network 3, the sent data is written as outputs to the Master2 with the block AG_SEND.  You can 
drop this block into your network from the Libraries of blocks in the catalog ( → Libraries → 
SIMATIC_NET_CP → CP 300 → FC5 AG_SEND) 
 

Now save the OB1 block  ( → ). 
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Note:   Here the master is connected with 1 byte input data and 1 byte output data over a CP342-5DP 
on slot 5 (Module start address decimal: 256/Hexadecimal 100).  The input data should be in input byte 
IB40.  The data should be written into the other master from output byte QB40. 
 
 
 
37. The STEP 7- Program must now be downloaded into the PLC.  In our case, this can be done from 

the SIMATIC Manager.  There, highlight the folder Master1 and then click on download .  
The mode switch must be on STOP and the program equipment must be connected with the MPI-

Interface of the CPU! (→ SIMATIC Manager → Master1 → ) 
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38.  From the SIMATIC Manager, open the block OB1 for the ‘Master2’ with a double click( → OB1). 
 

 
 
39.  Optional:  Enter the properties of the OB1 for documentation and accept with OK ( →OK). 
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40. With LAD, STL, FBD: Program blocks, you now have an editor which gives you the possibility to 

generate your STEP 7- Program.  Here the organization block OB1 was already opened with the 
first network.  In order to generate your first logical operation, you must highlight the first network.  
Now you can write your first STEP 7- Program.  Several programs can usually be divided into 

networks.  Open a new network by clicking on the network symbol  . 
 
Here the received data is read into network 1 as inputs from Master 2 with the block AG_RECV. You 
can drop this block into your network from the Libraries of blocks in the catalog ( → Libraries → 
SIMATIC_NET_CP → CP 300 → FC6 AG_RECV) 
 
In network 3, the sent data is written as outputs to the Master2 with the block AG_SEND.  You can 
drop this block into your network from the Libraries of blocks in the catalog ( → Libraries → 
SIMATIC_NET_CP → CP 300 → FC5 AG_SEND) 
 

Now save the OB1 block  ( → ). 
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Note:   Here the master is connected with 1 byte input data and 1 byte output data over a CP342-5DP 
on slot 5 (Module start address decimal: 256/Hexadecimal 100).  The input data should be in input byte 
IB40.  The data should be written into the master from output byte QB40. 
 
 
41. The STEP 7- Program must now be downloaded into the PLC.  In our case, this can be done from 

the SIMATIC Manager.  There, highlight the folder Master2 and then click on download .  
The mode switch must be on STOP and the program equipment must be connected with the MPI-

Interface of the CPU! (→ SIMATIC Manager → Master2 → ) 
 

  
 
42.  Through the switching of the mode switch to RUN, the program is started. 
 

 

 


